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Experiment no1 

 
Objective:To study multimedia hardware system. 

                    a) Input devices (b) Output devices 
                    c) Communication devices 
 
Hardware and system software requirement: P-IV Processor, Ram 256mb, HDD 40 
GB , Windows. 

 
Software requirement: Windows 2003, windows XP. 
 
REQUIREMENTS: - Floppy Disc, Hard Disc, DVD, CD Rom, Input devices like Track 
Ball, Touch Screen, Mice, Flat Bed, Digital Camera, Output devices like Amplifier 
speaker, monitor, projector, Printer. 
 
THEORY: -Input devices :A great variety or input devices -from the familiar keyboard 
and handy mouse to touch screen and voice recognition setups can be used for 
development and delivery or a multimedia project 
. 
1) KEYBOARD: A keyboard is the most common method of interaction with a 
Computer. Keyboards provide various tactile responses and have variously layout 
depending upon your Computer system and keyboard -model. Keyboard is typically 
rated at least 50 million cycles.The most common keyboard for PCs is the 1011 style, 
although many styles are available with one or more special keys LED’s.   
  
2) MICE:A mouse is the standard tool for interacting with a graphical user interface 
(QUI). All Macintosh computers require a mouse; on PCs, mouse: are not required 
but recommended. The buttons on the mouse provide additional user input, such as 
pointing and double clicking to open a document 
3) TRACK BALL:Track ball are similar to mice except that the cursor is moved by 
using one or more fingers to roll across the top of the ball. The track ball does not 
need the flat space required by a mouse. Track ball have at least two buttons;one for 
the user to click, and the other to provide the press and hold condition necessary for 
selecting & dragging operation.  
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4) TOUCHSCREEN:Touch screens are monitors that usually have a textured coating 
across the glass face. This coating is sensitive to pressure and register the location 
of the user’s finger when it touches the screen. The touch mate system, which has no 
coating, actually measures the pitch roll, and yaw rotation of the monitor when 
pressed by finger, and determine how much force exerted and the location where 
the  force was applied.  
 
5) MAGNETIC CARD ENCODERS AND READERS:Magnetic card setups are useful 
when you need an interface for a data- base application or multimedia project that 
tracks users. You need both card encoder and a card reader for this type of interface. 
The encoder connects to the computer at the serial port and transfer information to 
magnetic strip of tape on the back of the card.   
  
6) FLAT-BED SCANNERS:A scanner may be the most useful piece of equipment 
you will use in the course of producing a multimedia project. There are flat bed 
scanner and handheld scanners. Most commonly available are gray -scale and color 
flat- bed scanners that provide a resolution of 300 or 600 dots per inch. Professional 
graphics houses may use even higher resolution unit.   
 
7) OPTICAL CHARACTER RECOGNITION (OCR) DEVICES:OCR sofware, such as 
omni page from cacre or perceive from ocron, to convert printed matter to ASCII text 
files in our computer. We can also convert paper document into a word processing 
document on our computer without retyping or rekeying.An OCR terminal can be of 
use to multimedia developer because it recognizes not only  printed characters but 
also handwriting.   
 
8) INFRARED REMOTES:An infrared remote unit Iets a user interact with our project 
while we are freely moving about. Remotes work like mice and trackballs, except 
they use infrared light to direct the cursor and require no cables to communicate. 
Remote mice work well for a Iecture or other presentation in an auditorium or similar 
environment, when the speaker needs to move around the room.   
 
9) VOICE RECOGNITION SYSTEM:Voice recognition system facilitates hands free 
interaction with your project. These system usually provide a unidirectional cardiod, 
noise canceling microphone that automatically filters out background noise. Most 
voice recognition system currently available can trigger common events such as 
Save, Quit, Open, Print etc.The Macintosh A V and Power Macintosh computer 
include voice recognition capability and add on sound board such as the Sound 
blaster or Diamond Sonic Sound and other provide this features for PCs 
10) DIGITAL CAMERA:Digital Camera use the same technology i.e. CCD as video 
camera uses. They capture the still images of a given no. of pixels and the images 
are stored in camera's memory to be uploaded later to a computer. The higher the 
mega pixel rating, the higher the resolution of camera.Images are uploaded from the 
camera's memory using a serial, parallel cable. 
 
b) OUTPUT HARDWARE: - 
Presentation or the audio and the visual components or our multimedia project 
requires hardware that may or may not be included with the computer itself- 
speakers, amplifiers, monitor, motion video devices and capable storage devices. 
There is no greater test of benefit of good output hardware than to feed the audio 
output of your computer into an external amplifier. 
 

1) AUDIO DEVICES:All Machintosh are equipped with an internal speaker and a 
dedicated sound chip and they are capable of audio output without additional 
hardware and /or software.To take advantage of built in stereo sound, 



Multimedia & Web Technology Lab Manulal: 4
th 

semester(CSE) 3 

external speakers are required. Digitizing sound on your Machintosh requires 
an external microphone and sound editing/recording software such  as Sound 
edit 16 from Macromedia, Sound Forge. 
 

2) AMPLIFIERS ANS SPEAKERS:Often the  speakers we use during a project 
development will not be adequate for development of multimedia 
project.Speakers with built in amplifier are important when our project will be 
presented to a large audience. 
 
 

3) MONITORS:The monitors we need for development of multimedia projects 
depend on the type of application we are creating.A wide variety of monitors 
areavailable for both Machintosh and PCs.High-end, large screen graphics 
monitors and LCD panels are available for both, and they are 
expensive.Serious multimedia developers will often attach more than one 
monitor to their computers, using add-on graphics boards.This is because 
many authoring system allow us to work with several open windows at a time 
so we can dedicate one monitor to viewing the work we are creating 
ordesigning and can perform various editing tasks in windows on other 
monitor that do not block the view of work 
. 

4) VIDEO DEVICES:Message medium has the visual impact of video with a 
video digitizing board installed in computer, can display a television picture on 
monitor. Some boards include frame-grabber features for capturing the 
images and turning it into a color bitmap, which can be saved as a PICT or 
TIFF file and then used as a part of a graphics or a background project. 
 

5) PROJECTORS:When we need to show material to more viewers that can huddle 
around a computer monitor, we will need to project it onto a large screen or even a 
white painted wall. Cathoda-ray tube projectors, liquid crystal display (LCD) panel 
attached to an overhead projector, stand alone LCD projectors, and light-valve 
projectors are available to splash work onto big screen surfaces.   
 
6) PRINTERS:With the advent of reasonably priced color printers, hard copy output 
has entered the mutimedia scene. From storyboards to presentation to production of 
collateral marketing material, color printers have become an important part of the 
multimedia development environment.Color helps clarify concept, improve 
understanding and retention or information, and organize complex data. Xerox offers 
both solid ink and laser options. 
 
c) COMMUNICATION DEVICES 
Many multimedia application are developed in workgroups comprising instructional 
designers, writers, graphics artists, programmers, and musician located in the same 
office space or building. The workgroup member's computers typically arc connected 
on a local area network (LAN) the client's computers, however, may he thousand 
miles distant, requiring other methods of good communication.In the work place us 
quality equipment and software for your communication setup. The cost in both the 
time and money of stable and fast networking will be returned to you. 
1) MODEMS:Modems can be connected to your computer externally at the serial port 
or internally as a separate board. Internal modems often include fax capability.Be 
sure  that the  modem is Hayes compatible.  Hayes AT standard commmand set 
allows us to work with most software communication packages. 
Modem speed, measured in band, is the most important consideration. Because the 
multimedia files that contain the graphics, audio resources, video samples and 
progressive version of the project are usually large and in many cases we need to 
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move as much data in short period of time. Compression saves significant 
transmission time and money, especially over long distance 
. 
2) ISDN:For higher transmission speed, we will need to use Integrated Service Digital 
Network (ISDN), switched -56, TI, T3, DSL, ATM etc. ISDN lines are popular 
because of their fast 128 kbps data transfer rate- four to five times faster than the 
more common 28.8 kbps analog modem. ISDN lines are important for Internet 
accessing, Networking and audio and video conferencing. They are more expensive 
than the convention analog lines, so analyze your costs and benefits carefully before 
upgrading to ISDN. Newer and faster Digital Subscriber Line (DSL) technology using 
copper lines and promoted by the telephone companies may overtake ISDN. 
 
3) CABLE MODEM:Cable modems usually send and receive data symmetrically -
they receive more (faster) than they send. In the downstream direction from provider 
to user, the data is modulated and placed on a common 6 Mhz television carrier, 
somewhere between 42 MHz & 750 MHz. The upper stream channel, or reverse 
path, from user to provider is more difficult to engineer because cable is more noisy 
environment with interference from HAM radio, CB radio, home appliances, loose 
connections etc.  
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                                                     Experiment no.2   
Objective: To study the Multimedia basic software tools.  

 
Hardware and system software requirement: P-IV Processor, Ram 256mb, HDD 40 
GB , Windows. 

 
Software requirement: Windows 2003, windows XP. 
Theory: 

a. Text editing and Word processing tools: - A word processor is usually the first 
software tool computer users learns. From letter invoice and story boards to 
project content word processors may also be our most often used tool, as we 
design or build a multimedia project. Word processor such as Microsoft Word 
and Word Perfect are powerful that includes spell checkers, table formatters, 
templates for letters, resume purchase orders and other common documents. 
In many word processor we can actually embed multimedia elements such as 
sound, images and video etc.  

b. OCR software network: - With optical character recognition (OCR) software, a 
flat-bed scanner and our computer, we can save many hours of rekeying 
printed words, and get the job done faster and more accurately than roomful 
of typists. OCR software turns bitmapped characters into electronically 
recognizable ASCII text. A scanner is typically used to create the bitmap. 
Then the software breaks the bitmap into chunks according to whether it 
contains text or graphics by examining the texture and density of area of the 
bitmap and by detecting edges. The text areas are then converted into ASCII 
character using probability and expert system algorithms.  

c. Painting and Drawing tools: - Painting and drawing tools as well as 3D 
modelers, are perhaps the most important items in your toolkit because of all 
multimedia elements, the graphical impact of our project will likely have the 
greatest influence on the end user. Painting software such as Corel draw, free 
hand is dedicated to producing vector based line art easily printed to paper at 
high resolution.  

d. 3D modeling and animation tools: - With 3D modeling software,object 
rendered in perspective appear more realistic. We can create stunning 
scenes and wander through them by choosing just the right lighting and 
perspective for our final renedered image. Powerful modeling packages  

e. such as Infini-D, auto desk, strata vision’s, secular logo motion, wave front, 
aids soft images. Important for multimedia developers, many 3D modeling 
applications also include export features enabling us to save a moving view or 
journey through our scenes as a quick time or AVI animation file. Each 
rendered 3D image takes from a few seconds to few hours to complete, 
depending upon the complexity of the drawing and the number of drawn 
objects included in it. A good 3D modeling tool should include the following 
features:  

i. Ability to drag and drop primitive shapes into a scene.  
ii. Lathe and extrude features.  
iii. Color and texture mapping.  
iv. Ability to create and sculpt organic objects from scratch 

with Bezier spline drawing tools.  
v. Unlimited cameras with  focal length.  
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e. Image editing tools: - Image editing applications are specialized and powerful 
tools for enhancing and retouching existing bit-mapped images. These 
applications also provide many of the features and tools of painting and 
drawing programs and can be used to create images from scratch as well as 
images digitized from scanners, video frame grabbers, digital camera clip art 
files or original artwork files created with painting or drawing package.  

f. Animation: - Video and digital movie tools : today the most widely used tool 
for creating multimedia animations for Machintosh and Windows environment 
is Macromedia director. Animations and digitized video movies are sequences 
of bit-mapped graphics scene, rapidly played back. Most authoring tools 
adopt either a frame or object oriented approach to animation, but rarely both. 
Moviemaking tools typically take advantage of quick time for Machintosh and 
Windows and Microsoft video for Windows technology and let you create, edit 
and present digitized motion video segments, usually a small window in your 
project. To make amovie from video, you need special hardware to convert 
the analog video signal into digital data movie making tool such as Premer, 
videoshop, media studio pro and let you edit and assemble video clips 
captured from camera, tape and other digitized audio or midi files. 

g. Sound editing tools: - System sounds are shipped with both Machintosh  and 
window system, and they are available as soon as we install the operating 
system. System sounds and beeps are used to indicate an error, warning or 
special user activity. Using sound editing software we can make our own 
sound effects. We need software for editing digital sounds. Although we can 
usually incorporate MIDI sound files in our multimedia project without learning 
any special skill, using editing tool to make our own MIDI file requires that we 
understand the way music is sequenced, stored and published. We need to 
know about tempos, clips, notations and instruments. And we will need a 
MIDI synthesizer or device connected to our computer. Many MIDI 
applications provide both sequencing and notation capabilties, and some let 
you edit both digital audio and MIDI within the same application.  
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                                                            EXPERIMENT NO. 3 

 

Objective: To Design a simple web page using html tags. 
 
Hardware and system software requirement: P-IV Processor, Ram 256mb, HDD 40 
GB , Windows. 

 
Software requirement: Windows 2003, windows XP. 
 
 

Theory:The Web pages or materials in the form of  hypermedia documents 
accessed through the 
            Internet, cab be located anywhere in the world. Hypertext Markup 
Language (HTML).  HTML is powerful authoring language and found in 
different versions like HTML 4.2,  HTML 4.0, HTML 3.2, HTML 3.0 and HTML 
2. HTML element can be used to define document structure & format, HTML 
element is the inclusive region defined by either a single tag or a pair of tags.  
A tags is a string in the language surrounded by a less than (<) and a greater 
than (>) sign.   A opening tag does not begin with a slash (/).  An ending or 
closing tag is a string that begins with a slash (/). 

                                                 HTML documents format textual information 
with embedded markup tags that provide style and structure information.  
Whole document in HTML is surrounded by <HTML> and </HTML>. 
HOW TO CREATE HTML DOCUMENT  
HTML document cab be created using any HTML editor and text editor like 
notepad etc. 
STEPS FOR CREATING A SIMPLE HTML PROGRAM 
 
 
 
1.  Go to Start -> Programs->Accessories->Notepad 
2.  Begin with a document type tag and an <HTML> opening tag. Enter the 
following line in your doc. 
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      <HTML> 
3.  Indicate that you are beginning the head element of document by issuing 
the <HEAD> opening tag.  If a <HEAD> element is included, it must appear 
within 
 <HEAD> 

4. The <TITLE> element is used to indicate the title of an HTML 
document. <TITLE> tags are placed with in the head component of a 
document and the title is placed between the opening and closing 

<TITLE>  
tags.  Add 

this 
<TITLE> 
element 

to your 
document
. 

<TITLE>My 
First 

Page</TITLE> 
5. To end 

the head 
area 

issue a <HEAD> closing tag 
   </HEAD> 

 Thus the <HEAD> element is nested within the <HTML> element. 
6.  At this point the body of the document is developed.  A <BODY> opening 
tag 

indicates that this point has been reached.  Enter the following line. 
<BODY> 
7.  In this case, the body of document contains a simple text statement for 
now,  add 

the following statement in your file. 
       Hello World ! 
 
8.  A </BODY> closing tag marks the end of the <BODY> element.  Similar to 
the 
     Head element, the <BODY>  element is also completely nested within the 
     <HTML> element.  To end the <BODY> element, issue the closing tag in 
your 
     document. 
 
    </BODY> 
9.  Finally, terminate the <HTML> tag with </HTML> as shown below: 
     
 
10.    Save your document as mypage.html 
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11. To view the document open the .html document in the browser. 
 
Program input and output: 
 <HTML> 
 <HEAD> 
 <TITLE> My first webpage.</TITLE> 
 <BODY> 
 
  HELLO  WORLD ! 
 
  </BODY> 
 </HTML> 
 
Observation:The program is running successfully. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Multimedia & Web Technology Lab Manulal: 4
th 

semester(CSE) 10 

 

                                    EXPERIMENT NO. 4 

 Objective: To create   a html page using list attributes. 

(a) Orderdered lists 
(b)  unordered lists 

               (c)  defination lists 
            (d)  nesting lists 
 

Hardware and system software requirement: P-IV Processor, Ram 256mb, HDD 40 
GB , Windows. 

 
Software requirement: Windows 2003, windows XP. 
 
 

Theory:A.orderdered lists: To display items in a  specific order  such  as a set  of  

instruction  or  a table  of  content .Also  use  various   styles while  creating  a list. 

                  Syntax:  <OL> 

                                  <LI>………… 

                                   <LI>………… 

                                   </LI> 

Note: OL stand  for  order list and  LI stand  for list. 

<ol> 
ordered 
list 

Numbered 
 
<ol> 
<li>List item 1</li> 
<li>List item 2</li> 
<li>List item 3</li> 
<li>List item 4</li> 
</ol> 
 
Numbered Special Start 
 
<ol start="5"> 
<li>List item 1</li> 
<li>List item 2</li> 
<li>List item 3</li> 
<li>List item 4</li> 
</ol> 
 
Lowercase Letters  

<ol type="a"> 
<li>List item 1</li> 
<li>List item 2</li> 
<li>List item 3</li> 
<li>List item 4</li> 
</ol> 
 
Capital Letters  

<ol type="A"> 
<li>List item 1</li> 
<li>List item 2</li> 

Numbered 

       1.List item 1  

       2.List item  2 

       3. List item 3 

4. List item 4  

Numbered Special Start 

5. List item 1  
6. List item 2  
7. List item 3  
8. List item 4  

Lowercase Letters 

a. List item 1  
b. List item 2  
c. List item 3  
d. List item 4  

Capital Letters 

A. List item 1  
B. List item 2  
C. List item 3  
D. List item 4  
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<li>List item 3</li> 
<li>List item 4</li> 
</ol> 
 
Capital Letters Special Start  

<ol type="A" start="3"> 
<li>List item 1</li> 
<li>List item 2</li> 
<li>List item 3</li> 
<li>List item 4</li> 
</ol> 
 
Lowercase Roman Numerals  

<ol type="i"> 
<li>List item 1</li> 
<li>List item 2</li> 
<li>List item 3</li> 
<li>List item 4</li> 
</ol> 
 
Capital Roman Numerals  

<ol type="I"> 
<li>List item 1</li> 
<li>List item 2</li> 
<li>List item 3</li> 
<li>List item 4</li> 
</ol> 
 
Capital Roman Numerals 
Special Start  

<ol type="I" start="7"> 
<li>List item 1</li> 
<li>List item 2</li> 
<li>List item 3</li> 
<li>List item 4</li> 
</ol> 

Capital Letters Special Start 

C. List item 1  
D. List item 2  
E. List item 3  
F. List item 4  

Lowercase Roman Numerals 

i. List item 1  
ii. List item 2  
iii. List item 3  
iv. List item 4  

Capital Roman Numerals 

I. List item 1  
II. List item 2  

III. List item 3  
IV. List item 4  

Capital Roman Numerals 
Special Start 

VII. List item 1  
VIII. List item 2  
IX. List item 3  
X. List item 4  

 
    
c: Also customize  ordered list  by  using  any  ordered  value  in place  of 1,2,3and 
so on .this can be done  by  using  tag. 
 
Types  of  attributes are: 
 
1= for  Arabic  number ( 1,2,3,………….) 
i= for  lower  case  roman  no. (i, ii , iii,………) 
 
 I= for  upper  case roman no.(I, II, III,………..) 
a= for  lower   case  English alphabets (a,b,c………..) 
A=for  upper case English alphabets(A,B,C………….) 
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The  syntax  of <OL> tag with these attributes: 
 
:  <OL type = “……”>, or <OL start =”…….”> 
                                  <LI>………… 
                                   <LI>………… 
                                   </OL> 
 
Program input and output: 
 
       <HTML> 

       <HEAD> 
        <TITLE> ORDERED LIST</TITLE> 
         <BODY> 
      <H2> CONTENTS</H2> 
         <OL> 
           <LI> introduction 
            <LI> About Us 
           <LI> Catalogue 
             <LI> Contact Us 
</OL> 
</BODY> 
</HTML> 

ORDERED LIST 

CONTENTS 

1. introduction  

2. About Us  

3. Catalogue  

4. Contact Us  

 

 
 
  

B. UNORDERED LISTS: An unordered  list  has  bullets  placed  in  front  of  
each  items. By  default,  round bullets(disc) appear  in front  of  each  item 
unless specified. 

                                   The  container  element  for  ordered list <UL> .UL  stand  
for unordered List.Here  also   each  item   should   start   with  empty  
element<LI>. 

                  Syntax:  <UL> 
                                  <LI>………… 
                                   <LI>………… 
                                   </UL> 
 

<ul> unordered list 
Example 1:<br> 
<br> 
<ul> 

Example 1: 

 List item 1  



Multimedia & Web Technology Lab Manulal: 4
th 

semester(CSE) 13 

<li>List item 1</li> 
<li>List item 2</li> 
</ul> 
<br> 
Example 2:<br> 
<ul type="disc"> 
<li>List item 1</li> 
<li>List item 2</li> 
<ul type="circle"> 
<li>List item 3</li> 
<li>List item 4</li> 
</ul> 
</ul> 

 List item 2  

 
Example 2: 

 List item 1  
 List item 2  

o List item 3  
o List item 4  

 
Customizing  unordered  list: Unordered  List  can  also  be  customized to  replace  
the  round  bullets (Disc) with  different  styles. 
  
The  type attributes  of  unordered list is: 
a.Disc 
b. Circle 
c.Sqare 
 
 
Program input and output: 
 
      <HTML> 
      <HEAD> 

 <TITLE> UNORDERED LIST</TITLE> 
 <BODY> 
 <H2> CONTENTS</H2> 
  <UL> 
           <LI> introduction 
            <LI> About Us 
           <LI> Catalogue 
             <LI> Contact Us 
          </UL> 

           </BODY> 
      </HTML> 

UNORDERED LIST  

CONTENTS 

 introduction  

 About Us  

 Catalogue  

 Contact Us  
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C. DEFINATION LISTS:  The  DL container  element  is  used  to  start  a 
definition list  DL  stands for   Definition  list <DL> is  the  opening  tag  and  
</DL>  is the  closing  tag. Within these  opening  and  closing tags ,  the  
empty  element < DT>  is used. DT stands for Definition Term This tag tells 
the browser  that this term  is  to be defined. After <DT> tag, <DD> tag is 
used. DD stands for Definition Description  and  is  also  an  empty element 
DD tells the  web Brower the  actual definition .Both the tags namely <DT> 
and < DD>  come  between  the  opening  and  closing  tags of  the  
Definition List. 

    
 
        
                              Syntax:  <DL> 
                                  <DT>………… 
                                   <DD>………… 
                                   </DL> 

<dd> 
definition 
description 

<dl> 
<dt>Definition Term</dt> 
<dd>Definition of the 
term</dd> 
<dt>Definition Term</dt> 
<dd>Definition of the 
term</dd> 
</dl> 

Definition Term  
Definition of the 
term  

Definition Term  
Definition of the 
term  

<dl> definition list 

<dl> 
<dt>Definition Term</dt> 
<dd>Definition of the 
term</dd> 
<dt>Definition Term</dt> 
<dd>Definition of the 
term</dd> 
</dl> 

Definition Term  
Definition of the 
term  

Definition Term  
Definition of the 
term  

<dt> definition term 

<dl> 
<dt>Definition Term</dt> 
<dd>Definition of the 
term</dd> 
<dt>Definition Term</dt> 
<dd>Definition of the 
term</dd> 
</dl> 

Definition Term  
Definition of the 
term  

Definition Term  
Definition of the 
term  

 
 
 
     <HTML> 
                              <HEAD> 
                              <TITLE> Microsoft Office</TITLE> 
                              
                              </HEAD> 
                               <BODY> 
                                

                                    <DL> 
                                  <DT>Microsoft Excel 
                                   <DD>A Spreadsheet Program 
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                                    <DT> Microsoft Word 
                                     <DD>  A Word Processing Program 
                                   </DL> 
                                  
                                    </BODY> 
</HTML> 

 

Microsoft Office 

  

Microsoft Excel  

A Spreadsheet Program  

Microsoft Word  

A Word Processing Program  

 

 
NESTING LISTS: To display  additional  information  about  an  item  in  a list, can 
create  another  list  within  that  list. This  procedure  of  creating  a list  within  a list  
called  nested  list. 

Example: Creating a nested list. 
           
       <HTML> 
       <HEAD> 
        <TITLE> NESTED LIST</TITLE> 
         <BODY> 
      
        <H2> CONTENTS</H2> 
         <UL  TYPE =” circle”> 
         <LI> introduction 
         <LI> About Us 
          <LI> Catalogue 
           <OL TYPE =”a”> 
                           <LI> computer books 
                           <LI> text book 
                            <LI> General books 
                            <LI> Educational charts 
                            </OL> 
         </UL> 
        </BODY> 
 
        </HTML> 
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NESTED LIST 

CONTENTS 

o introduction  

o About Us  

o Catalogue  

a. computer books  

b. text book  

c. General books  

d. Educational charts  

 

 
 
Observation:The program is running successfully.                                                         
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                                                  EXPERIMENT NO. 5 

 Objective:  To design a table through html. 

 
Hardware and system software requirement: P-IV Processor, Ram 256mb, HDD 40 
GB , Windows. 

 
Software requirement: Windows 2003, windows XP. 

 
Theory: Table:  Create  the  table  structure that  is  enter  the  table  tag <table>. 

Specifies  row  and  columns and Specifies heading. 

                                                       Enter  the  data  in  table  set. Create  a table  to  

display  information  on  a  web  page  some  time   may like  to display  an 

information in tabular  for mate . 

           A Table  has  three parts- 

1. Row: - which is horizontal line of data. 

2. Header  cell :-  which  contains  text  that  describe  the data  in  a row  or  

column. 

3. Data cell :-  which   contain  data  or  information  to  display. 

         Basic table tags:- 

 

          Tag                          Uses 

 

1. <TABLE>                 Marks  a table  within  an  html  documents. 

 

2. <TR>                         Marks  a  row  within  a table. 

 

3. <TD>                         Marks  a  cell  (table  data)  within  a row. 

 

4. <TH>                         Marks  a heading  cell  within  a row. 

 

Product code Product name  Price per unit quantity Total prices 

Po1 Atlas 40 2 80 

Po2 Ocy-html 70 5 350 

 

<table> table Example 1: 

 

<table border="4" cellpadding="2" cellspacing="2" width="100%"> 

<tr> 

<td>Column 1</td> 

<td>Column 2</td> 

</tr> 

</table> 
 

Example 2: (Internet Explorer) 

 

<table border="2" bordercolor="#336699" cellpadding="2" cellspacing="2" 

width="100%"> 

<tr> 

<td>Column 1</td> 

<td>Column 2</td> 

http://www.web-source.net/216_color_chart.htm
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</tr> 

</table> 
 

Example 3: 

 

<table cellpadding="2" cellspacing="2" width="100%"> 

<tr> 

<td bgcolor="#cccccc">Column 1</td> 

<td bgcolor="#cccccc">Column 2</td> 

</tr> 

<tr> 

<td>Row 2</td> 

<td>Row 2</td> 

</tr> 

</table> 
Example 1: (Tip) 

Column 1 Column 2 

 

Example 2: (Tip) 

Column 1 Column 2 

 

Example 3: (Tip) 

Column 1 Column 2 

Row 2 Row 2 

<td> table data <table border="2" cellpadding="2" cellspacing="2" width="100%"> 

<tr> 

<td>Column 1</td> 

<td>Column 2</td> 
</tr> 

</table>  

Column 1 Column 2 

<th> table header <div align="center"> 

<table> 

<tr> 

<th>Column 1</th> 

<th>Column 2</th> 

<th>Column 3</th> 
</tr> 

<tr> 

<td>Row 2</td> 

<td>Row 2</td> 

<td>Row 2</td> 

</tr> 

http://www.web-source.net/216_color_chart.htm
http://www.web-source.net/216_color_chart.htm
javascript:void(0);
javascript:void(0);
javascript:void(0);
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<tr> 

<td>Row 3</td> 

<td>Row 3</td> 

<td>Row 3</td> 

</tr> 

<tr> 

<td>Row 4</td> 

<td>Row 4</td> 

<td>Row 4</td> 

</tr> 

</table> 

</div>  

Column 1 Column 2 Column 3 

Row 2 Row 2 Row 2 

Row 3 Row 3 Row 3 

Row 4 Row 4 Row 4 

<title> document title <title>Title of your HTML page</title> Title of your web 

page will be viewable in the title bar. (Tip) <tr> table row <table border="2" 

cellpadding="2" cellspacing="2" width="100%"> 

<tr> 
<td>Column 1</td> 

<td>Column 2</td> 

</tr> 
</table>  

Column 1 Column 2 

 
Program input and output: 

  

         <HTML> 

         <HEAD> 
         <TITLE>Creating  Table</Title> 
         </HEAD> 
        <BODY> 
        < h1align = center> Bill</h1> 
        <TABLE BORDER =5> 
        <TR> 
        <TH> Product  Code </TH> <TH> Product Name </TH> <TH> 
Priceperunit</TH><TH> Quantity </TH><TH>   
        Total Price</TH> 
        </TR> 
        <TR> 
       <TD>po1</TD><TD>Atlas</td> <TD> 40</TD><TD> 2</TD><TD>80</TD> 
       </TD> 
       <TR> 
        <TD> po2/TD><TD>ocy-html</TD><TD> 70</TD><TD>5</TD> <TD> 
350</TD> 
       </TABLE> 
       </BODY> 
       </HTML> 
  

javascript:void(0);
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Creating Table 

                                                    Bill 
  

Product code Product name  Price per unit quantity Total prices     

Po1 Atlas 40 2 80     

Po2 Ocy-html 70 5 350     
 

 
Observation:The program is running successfully. 
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                                      EXPERIMENT NO. 6 

 
Objective :  To design a form using html. 
 
Hardware and system software requirement: P-IV Processor, Ram 256mb, HDD 40 
GB , Windows. 

 
Software requirement: Windows 2003, windows XP. 
 
Theory:  Creating  Form : Setting  of a form :- TO set  up  a form  add  information  to  
the form . To set up  a form, to specify two important information that is Method  and 
Action  property of <FORM> tag. 
 
Property of Form Tag:-   

1.Method:   its tells the form  how  to  transfer  the  data  to  the  form processor, which 
is CGI script or  e-mail address.        

 
   The two values to the     Method property which are: 
 

a. GET- if  the  Method of is set  to get  then the  data in  the form is  given  to  
the  form of  an environment variable. If  no  Method property is  given  in  
<FORM> tag  the  default  property is  set  to  GET. 

 
b. POST: if  the  Method of is set  to get  then the  data in  the form is  given  to  

the  form of  an environment variable. If  no  Method property is  given  in  
<FORM> tag  the  default  property is  set  to  GET. 

 
c.  

ACTION property  of the <FORM> tag  tells  what  the  from  should  take  when  the    
user  presses  the   SUBMIT  button .More  often then not, this  is  a URL  pointing  to 
a CGI program. For example. 
 
                     <FORM METHOD =”post” ACTION=” /cg-bin/priya.pl”> 
      
Note  here  that the  action  property  is  set  to the  location  of  a  CGI script  on  
web  server  that  will  process  the  information  submitted by  the form. 
 
Sometimes  a  user who  does  not  know  these  scripting  languages  and  wants to  
obtain information  or  opinion through  forms on  his e-mail address , in those  case  
set  the   ACTION  property  to  the  e-mail  address of  the  recipient.  For example: 
 
<FORM  METHOD =”post”  ACTION = “mailto: priya@gmail.com”> 
  
 Note  here  that  set  the  ACTION   property  to   an e-mail link, so  in  this  case  all 
the data  in  the  form  will be  sent  to  the  e-mail  address specified  in  the  
ACTION property. Also  replace priya@gmail.com with  any  of  the  e-mail address, 
where to  sent the data. 
 
Remember  when  set  the  ACTION   property  to  an  e-mail link  then  send  the  
data, that will receive  an  e-mail from  the  visitor  with  an  attachment  enclosed  to 
it . 
 
Note :  if  like to  receive  the  e-mail  without  the attachment,  in  a  text  form, then  
in  the <FORM>  tag type,  ENCTYPE = “TEXT/PLAIN”. 

mailto:priya@gmail.com
mailto:priya@gmail.com
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<form> form <form action="mailto:you@yourdomain.com"> 

Name: <input name="Name" value="" size="10"><br>  

Email: <input name="Email" value="" size="10"><br> 

<center><input type="submit"></center> 

</form>  

Name: (Tip)  

Email:  

 

 

<input> input field Example 1: 

 

<form method=post action="/cgi-bin/example.cgi"> 

<input type="text" size="10" maxlength="30"> 

<input type="Submit" value="Submit"> 

</form>  

Example 1: (Tip) 

 

Submit
 

<input> 

(Internet Explorer) input field Example 2: 

 

<form method=post action="/cgi-bin/example.cgi"> 

<input type="text" style="color: #ffffff; font-family: Verdana; font-weight: bold; 

font-size: 12px; background-color: #72a4d2;" size="10" maxlength="30"> 

<input type="Submit" value="Submit"> 

</form>  

Example 2: (Tip) 

 

Submit
 

<input> input field Example 3: 

 

<form method=post action="/cgi-bin/example.cgi"> 

<table border="0" cellspacing="0" cellpadding="2"><tr><td 

bgcolor="#8463ff"><input type="text" size="10" maxlength="30"></td><td 

bgcolor="#8463ff" valign="Middle"> <input type="image" name="submit" 

src="yourimage.gif"></td></tr> </table> 

</form>  

Example 3: (Tip) 

 

 
<input> input field Example 4: 

 

<form method=post action="/cgi-bin/example.cgi"> 

javascript:void(0);
javascript:void(0);
javascript:void(0);
javascript:void(0);
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Enter Your Comments:<br> 

<textarea wrap="virtual" name="Comments" rows=3 cols=20 

maxlength=100></textarea><br> 

<input type="Submit" value="Submit"> 

<input type="Reset" value="Clear"> 

</form>  

Example 4: (Tip) 

 

 

Submit Clear
 

<input> input field Example 5: 

 

<form method=post action="/cgi-bin/example.cgi"> 

<center> 

Select an option: 

<select> 

<option >option 1</option> 

<option selected>option 2</option> 

<option>option 3</option> 

<option>option 4</option> 

<option>option 5</option> 

<option>option 6</option> 

</select><br> 

<input type="Submit" value="Submit"></center> 

</form>  

Example 5: Tip) 

 

Select an option: 
option 2

 

Submit
 

<input> input field Example 6: 

 

<form method=post action="/cgi-bin/example.cgi"> 

Select an option:<br> 

<input type="radio" name="option"> Option 1 

<input type="radio" name="option" checked> Option 2 

<input type="radio" name="option"> Option 3 

<br> 

<br> 

Select an option:<br> 

<input type="checkbox" name="selection"> Selection 1 

<input type="checkbox" name="selection" checked> Selection 2 

<input type="checkbox" name="selection"> Selection 3 

javascript:void(0);
javascript:void(0);
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<input type="Submit" value="Submit"> 

</form>  

Example 6: (Tip) 

 

Select an option: 

Option 1 

Option 2 

Option 3 

 

Select an option: 

Selection 1 

Selection 2 

Selection 3 
 

Program input and output: 
 

<html> 

 

<head> 

<title> creating text box</title> 

</head> 

<body><h3>please provide information</h3> 

<p><form method="post" action="mailto: priya@gmail.com" enctype="textplain"> 

 enter your name:<input type="text" name="yourname" size="30" maxlength="5"> 

<br> 

address:<input type="text" name="address" size="30" maxlength="5"> 

<br> 

city:<input type="text" name="city" size="30" maxlength="5"> 

<br> 

pincode:<input type="text" name="pincode" size="30" maxlength="50"> 

<br> 

telephone:<input type="text" name="telephone" size="40" maxlength="50"> 

<br> 

credit card no:<input type="password" name="credit" size="20" maxlength="16"> 

<br> 

which sports you like? 

<br> 

<input type="checkbox" name="sport" value="cricket" checked>cricket 

<input type="checkbox" name="sport" value="football"> football 

<input type="checkbox" name="sport" value="hockey">hockey 

<input type="checkbox" name="sport" value="tennis">tennis 

<br> 

<br> 

  

comment: 

<br> 

<textarea name="comments"  rows="10" cols="40"> 

javascript:void(0);
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</textarea> 

</p> 

</form> 

</body> 

</html> 

 

Creating text box 

please provide information 

enter your name:   

address:   

city:   

pincode:   

telephone:   

credit card no:   

which sports you like?  

cricket football hockey tennis  

 

comment:  

 
 

 

Observation:The program is running successfully. 
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                                                    EXPERIMENT NO 7 

 
Objective :  To design a frame using html. 
 
Hardware and system software requirement: P-IV Processor, Ram 256mb, HDD 40 
GB , Windows. 

 
Software requirement: Windows 2003, windows XP. 
 
 
Theory:The introduction  of  frames  can  create  web  pages  that  look  and  feel  
entirely different  from  other   web  
             pages- pages  that  have  tables  of  contents , banners,  footnotes  and  
sidebars, just  to  name  a few   
             common  features  that  frames  can  give.  
                 
                    At   the   same  time, frames   change  what  a page  means  to   the  
browser  and  to  the  readers. 
 
                                    Unlike  all  the  preceding  example: which  use  a  single  html  
page  to   display  a screen  of  information  .Create  web  sites using  frames   a 
single  screen  actually   consist   of  a number  of  separate  html   document  that  
interact  with  each  other. 
 
                                       The  frameset  document  also  includes  the  names  of  the  
html  document  that  will  appear  in  each  of  the  frames  .Each  of  the  remaining  
html document  contains  normal  html tags  that  define  the  physical  contents  of  
each  separate  frame  area. These documents are referenced by the frameset 
document. 
 
  
CREATING FRAMES: 1.Creating a frameset (or layout) document that determines 
the location and characteristics of the frames. 
 
2. Designate the frames and their contents. 
 
3. Format the frames. 
 
FRAMESET TAGS AND ATTRIBUTES 
 
Tag/Attributes                        Use 
 
<Frameset>                           Establishes  Frames  within  an  html  document. 
 
Rows=”n1,n2…”                  Sets  the  size  for  rows horizontal   frames-in  pixel, as  
a  percentage   or  as  a  proportion   of  the  remaining  space  with “*”. 
 
Cols=”n1, n2…”                   Sets  the  size  for  rows Vertical frames-in  pixel, as  a  
percentage   or  as  a  proportion   of  the  remaining  space  with “*”.  
 
<Frame>     Identifies  frame  characteries  and  initial   content. 
SRC= “URL”          Identifies  the   source    for  the   frame  content  as  a  standard  
URL. 
 



Multimedia & Web Technology Lab Manulal: 4
th 

semester(CSE) 27 

Name =”…….”         Labels   a  frame  so  that   it  can  be  targeted   or  referred  to  
from  other   frames   or   windows. 
 
 <No frames>               Sets    a   section   of  a  html  to   be   visible   to  no framed  
browsers.   
 
Advantages(Pros) of using Frames : 

 

1. One of the most beneficial feature of frames is it lets the user to have multiple 

pages in the same browser.  
 
2. Using frames we can keep one part of the page static while changing the other 
parts of the page. 
 
3. If we create a top frame we can use it as a header i.e, as that page is static it acts 
like an include page. 
 
4. Frames can be used to reduce server load, as there is no need to reload all the 

pages when ever a new page is visited. 

 

 

Disadvantages of using Frames : 

1. One of the main disadvantage of frames is search engines will not deal with them 

properly. i.e, search engines (including most popular ones) will not index pages 
containing frames as its hard for them to search for a specific content and move 
backwards to check to which frameset each page belongs to and retrieve all the 
pages in the frameset.  
 
2. Its hard to navigate through pages in frames when we have more than two or three 
frames. 
 
3. Its difficult to print the content of all frames when compared to a normal web page.  
 
4.. Some browsers doesn't support frames, so we need to place the content 
seperately for the people who doesn't have frames using <noframes> ... </noframes>  
 
5. We cannot bookmark individual pages using browser's Favourites Menu. 

    Frames 

<frameset cols="25%,75%"> 

  <frame src="page1.htm" /> 

  <frame src="page2.htm" /> 

</frameset> 

Program input and output: 
 
<HTML> 
<HEAD> 
<TITLE>  The frame  Tag</title> 
</HEAD> 
<FRAMESET  ROWS=”*,*,*”> 
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             <FRAME SRC=”DOCUMENT1.HTML”> 
              <FRAME SRC=”DOCUMENT2.HTML”> 
               <FRAME SRC=”DOCUMENT3.HTML”> 
 
</FRAMESET> 
 
</HTML> 
 
 

The frame Tag 

Document1 

Document2 
 

Document3 

 
Observation:The program is running successfully. 
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                                                 EXPERIMENT NO.  8 
Objective: To  using image tag for inserting image on html page. 
 
Hardware and system software requirement: P-IV Processor, Ram 256mb, HDD 40 
GB , Windows. 

 
Software requirement: Windows 2003, windows XP. 
 

 
               Theory: Image formats: when  developing   image,  also  consider  format  
option. Basically 

                                  use  GIF ,JPG  or PNG  formats. depending  on  the  user   want 
. 

  
                                 GIFS:  The   most  common  image  format   is  GIF,  which  is  an  
acronym  formed  from 

                                                Graphics  Interchange Format  developed  by  
CompuServe  for  online use.  

 
                                  JPG/JPEG: Jpg  stand for   Joint  Photographic  Expert  Group. 
This  image  format  is  the   
                                  second  most  popular  for  image  on  the  web. As  a  whole  , 
Jpg  image  are  less flexible  than  
                                  GIF  image    and   the  most  significant  advantage  of  JPG  is  
that  it  supports  million  of   
                                  color. 
 
                                     PNG:  PNG   stands  for  Portable Network  Graphics. This  
new  image  file  format  is  only 
                                    supported  by  the  most  recent  browser version ( Microsoft 
Internet Explorer 4) 

The Image Tag and the Src Attribute  

In HTML, images are defined with the <img> tag.  The <img> tag is empty, which 
means that it contains attributes only and it has no closing tag.  

To display an image on a page, you need to use the src attribute. Src stands for 
"source". The value of the src attribute is the URL of the image you want to display 
on your page.  

The syntax of defining an image: 

<img src="url" />  

The URL points to the location where the image is stored. An image named "boat.gif" 
located in the directory "images" on "www.w3schools.com" has the URL: 
http://www.w3schools.com/images/boat.gif.  

The browser puts the image where the image tag occurs in the document. If you put 
an image tag between two paragraphs, the browser shows the first paragraph, then 
the image, and then the second paragraph.  

    Image Tags <img src=> Inserts an image  
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   <img height=> Sets the height of an image 

<img width=> Sets the width of an image  

<img border=> Sets the border of an image  

<img alt=> Creates label for image  

<hr> Creates horizontal rule 

 <hr size=> Sets height of rule  

<hr width=> Sets width of rule, either in percentage or pixel value 

 <hr noshade> Creates shadow less rule 

 

 
                                 Inserting an image 
                                     To  insert  an  image   in  a Html  document, <IMG>  tag  is  
used . IMG  stands  for   
                                        Image  element   <IMG>  is  an  empty  element  and  has  
SRC ,  align, border, height, width 
                                etc. 
 
 
                          <img> image <img src="Earth.gif" width="41" height="41" 
border="0" alt="text describing 
                            the 

 
 

                         image" /> (Tip 

  

 Program input and output: 

 

<HTML> 

<HEAD> 

<TITLE>  Inserting  images</title> 

</HEAD> 

<BODY> 

<H2> EARTH</H2> 

<IMG Src=”C:\MY DOCUMENT\MY PICTURE\EARTH.BMP”> 

</BODY> 

</HTML> 

 

Inserting  images 

javascript:void(0);
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Observation:The program is running successfully. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

EARTH  
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                                                 EXPERIMENT NO.  9 

Objective:. To create, process and print graphics using adobe photoshop. 
 
 Hardware and system software requirement: P-IV Processor, Ram 256mb, HDD 40 
GB , Windows. 

 
Software requirement: Windows 2003, windows XP. 
 
 

Theory  : ABOUT PHOTOSHOP 
                Adobe Photoshop – the imaging software application - has become 
more than an integral part of graphic designers’ working tools. Photoshop has 
earned the reputation of being a mysterious, magical environment where 
reality is twisted and reshaped, where disintegrating family photos are returned 
to perfect condition, and where the line between illustration and photography is 
freely crossed Photoshop provides you some special features like, Image 
retouching, Advanced buttons for your web pages. This is best software 
application available in the market for Image Manipulation. 
 
 HOW TO WORK IN PHOTOSHOP 
How to open Photoshop 
 
Step 1:     Click on START 
Step 2:     Select Programs 
 
Step 3:     Select Adobe 
Step 4:     Select PhotoShop 5.x 
Step 5:     Click on Photoshop 5.x 
After finishing doing this you will get a screen like this (below): 
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The above screen provides you the tool bar and few other windows, but not 
the work 
Area. 
  
For work area 
Step 1:   Click on FILE 
 

Step 2:   Click on NEW 
 
The next screen will appear, which will require few inputs from you, like 
 

 

i. The height and width of the work area in pixel / inches / cm / points / picas / 
columns, 
ii. The resolution for the file 
iii. The image color mode Bitmap / Grayscale / RGB / CMYK / lab color 
iv. The last option for the type of background required white / background color 
/ 
transparent. 

v. Give a file name under “Name. 

vi. Click on OK 
The Screen looks like as given below 
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The normal 
size for work 
area is 640 

pixels (width) x 480 pixels (height) with the 
resolution 72 pixels/inch. 
 
Now as you have got the work area, you can start working on it With the help 
of the Photoshop tool bar you can create, edit, retouch, manipulate your 
 

drawing or imported image 
TO SAVE YOUR WORK 
 

Step 1:    Click on File 
Step 2:    Click on Save / Save as 
Step 3:    Select the directory under which the file you want to save 
Step 4:    Provide a name (if not provided at the time of creating a new file 
Step 5:    Click on Save 
 

For JPEG file format 
Step 1:    Click on File 
Step 2:    Click on Save a copy 
Step 3:    Select the directory under which the file you want to save 
Step 4:    Provide a name 
Step 5:   Select JPEG from under the “Save as” option 
Step 6:   Click on Save 
 

For GIF file format: 
Step 1:   Click on File 
Step 2:   Click on Export 
Step 3:   Click on GIF89a export 
You will get the following screen 
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Step 4:    without 
changing anything (as 
above) Click on OK 
Step 5:    Select the 
directory under which the 
file you want to save 
 

              

 

 

 

 

 

 

 

 

 

 

Click File > New (the screen look like as given below) 
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                      In the Document Setup window do the following: 
 
Step 1:    Select the page size (letter, Legal, Tabloid, A3, A4 etc.) 
Step 2:    Select the orientation {Tall (same as portrait) / Wide (same as 
landscape)} 
Step 3:    Check the options for double sided and facing pages or only double 
sided 
pages, if you want the pages to be in mirror of one another, or else don’t check 
the 
double-sided option this will give a normal page. When Double-sided is 
selected, side 
margins are labeled Inside and Outside. Otherwise, side margins become Left 
and 
Right. 
 
Step 4:    Insert the number of pages you require. 
Step 6:   Click on Numbers to select the type of page number (Numeric / 
Roman 
Alphabets). 

  

                      In the Document Setup 
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Step 7:   Set the output resolution (dots per inch). 
Step 8:   Select the Printer. 
Step 9:   After providing the details click on OK 
 
Now your environment looks like: 
 
 
 
 

 
 
TOOL BOX 
 
Choose Window > Show Tools or Window > Hide Tools to 
display or hide the toolbox 
 
 
 
 
 
                                                                                            

                                                           Pointer      
                                                                                            Text 
                                                                                                                                                                                             
                                                      Rotating  Crop 
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                                                           Line  Constrained Line 
 
                                                                     Rectangle Frame 
                                                                     Ellipse Frame 
                                                                Polygon Frame 
                                                                   Zoom 
 
                                                    Rectangle  
                                                    Ellipse 
                                                       
                                                      Polygon  
      
                                                      Hand 
 
 
 

                                                            

Pointer tool: Used to select, move, and resize text blocks and graphics. 
Text tool: Used to type, select, and edit text. 
Rotating tool: Used to select and rotate objects. 
Cropping tool: Used to trim imported graphics. 
Line tool: Used to draw straight lines in any direction. 
Constrained line tool: Used to draw vertical or horizontal lines. 
Rectangle tool: Used to draw rectangles and squares. 
Rectangle frame tool: Used to create a rectangular placeholder for text and 
graphics or 
you can define an area for the text / graphics. 
Ellipse tool: Used to draw ellipses and circles. 
Ellipse frame tool: Used to create a circular or oval placeholder for text and 
graphics or 
you can define an area for the text / graphics. 
Polygon tool: Used to draw basic polygons. 
Polygon frame tool: Used to create a polygonal placeholder for text and 
graphics or you 
can define an area for the text / graphics. 
Hand tool: Used to scroll the page or to preview and test hyperlinks. 
Zoom tool: Used to magnify or reduce an area of the page 
 
When you select any of these tools, you get the properties for that tool in the 
property 
bar. With the help of the property bar you can rotate, skew the shape and 
format the text. 
 
MENUS 
In PageMaker you will find these menus; File, Edit, Layout, Type, Element, 
Utilities View, Window and Help. The options available under these menus are 
given below. 
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File Menu: The options available under file menu are; New, Open, Recent 
Publication, Close, Save, Save as, Revert, Place, Acquire, Export, Document 
setup, Printer style, Print, Preferences, Send Mail and Exit You can Acquire 
either a source by selecting Select source or an image by selecting 
Acquire Image (only .tif file). You can export your file as Adobe PDF / HTML / 
Graphic / Text. You can set your preferences by selecting any of these options 
under Preferences General / Online / Layout adjustment / Trapping To change 
the rulers from Inches to Millimeter or any other measuring format do the 
following: Click on File > Preferences > General 
 On doing this, you will get the following screen 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In this select the type for “Measurement in”, select the type for “Vertical ruler”. 
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On selecting this two the 
horizontal and vertical 
nudge under control pallet 
will change to the same 
automatically. Horizontal 
nudge is dependent on 
“Measurements in” and 
vertical nudge is 
dependent on “Vertical 
ruler”. The different 
measuring formats are; 
inches  inches decimal, 
millimeters, picas and 
ciceros for “Measurement 
in” and for “Vertical ruler” 
you will find all these plus 
custom. For setting the 
font style, size, graphics 
size  etc. click on the 
“More” button for more 
preference. The screen 
looks like as given below: 
 
 

 
 
 
 
 
 
 

 
 
 

    

 

 

Edit Manu: The options 
available under edit 

menu are; Undo/Redo, Cut, Copy, Paste, Clear/Delete, Select all, Deselect all, 
Paste special, Paste Multiple, Insert object, Edit Story, Edit Original. You can 
insert any object (format) with the help of Insert Object. With the help of Paste 
multiple you can paste as many number of copies of an object at a single go. 
By selecting paste multiple you will get the following screen, all you have to do 
is to provide the number of copies you require and the Horizontal and Vertical 
offset (position) from the original object.  
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Paste Special 
will paste the 
object as 
Bitmap image 
: 
 Layout Menu: 
The options 

available 
under Layout 
menu are; 
Goto Page, 

Insert pages Remove Pages, Sort Pages, Go Back, Go Forward, Column 
Guides, Copy Master Guides Auto flow. These options helps to insert, remove 
pages, goto a particular page, either go forward or backward (pages), Inserting 
columns, interchange the pages (sort). 
Type Menu: The options available under type menu are; Font (for different 
fonts), Size (font size), Leading (line spacing), Type Style (bold / italic / 
underline etc), Expert Kerning, Expert Tracking and horizontal scale (these 3 
options are used for character spacing), Character (for formatting of the text) 
(screen given below), 
 
 
 
 
 
 
 
 
 
 
 
Paragraphs (used for paragraph alignment, spacing, indentation etc) (screen 
given below), 
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Indents / Tabs (used for specifying tabs) (screen given below  
                                                                                                                           
 

 

 

 

 

 

 

Hyphenation (used for defining the style and type hyphen) (screen given 
below), 
                                                                                                                                 

 

 

 

 

 

 

 

 

 

 

 

 

Alignment (left, center, right, justify or force justify; force justify will force the 
line to align justify), Style (used for defining the style of your text; body text, 
caption, hanging , headline or subheads), Define styles (same as style) 
(screen given below  
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Element Menu: The 
options available under 
Element menu are; Fill, 
Stroke, Fill & Stroke, 
Frame (attach content / 
Frame option / change 
to frame / next frame / 
previous frame / 
remove from threads / 
delete content), 
Arrange (bring to front / 
bring forward /  send 

backward / send to back), Align 
objects, Text wrap, Group, 
Ungroup, Lock position Unlock, 
Mask, Unmask, Image (image 
control / CMS(Color Management 
system) source / Photoshop 

effect). Polygon settings, Rounded corners, link into, Link options, Non  
printing, Remove transformation. Some of these options defined below . 
 
Fill: Used for filling an object created in PageMaker. Fill option provides 
different types of fills as shown below  
 

 
 
 
 
                 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Stroke: It is used for 
providing an outline to 
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the object created by 
using the PageMaker , 
tool. The different types 
of stroke options are as 
shown below . 
 
 
 
 
  

 
 
                    

 

 

 

Fill & Stroke: It is a combination of fill and stroke options. You can fill and 
stroke the object at the same time. The options available under this are same 
as that of fill option and stroke option. You can provide a color to your fill and 
stroke, adjust the color tint also can make it in reverse. Screen as shown 
below. 
 
 
 
 
                           

 

 

 

 

Align Objects: Used to align the objects 
created in your page. You can align or 
distribute them Vertically or Horizontally or 
both at the same time. Refer the screen 

below . 
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Polygon settings: You can create a shape using the polygon setting, as shown 
below:  
   
 
                       

 

 

 

 

 

 

 

 

 

 

 

 

To create a star:  
 
 

 

To create a triangle: Number of sides 3, star inset 0% 
 To create a square: Number of sides 4, star inset 0% 
 Rounded corners With this option you can give a rounded corner to the 

square object created by you using the 
square tool. Select the square and 
choose rounded corner, and  select the 
type of rounded corner you need from 
the window/screen (as shown below) 
and click OK  
 
  
 

 

 

 

Utilities Menu: The options available under utilities menu are; Plug-ins (for 
creating color library), Find, Find next, Change, Spelling, Book, Index entry, 
Show index, Create index, Create TOC, Define colors 
 These options are mainly used for finding a particular word and replacing it 
with a different word, checking the spelling, creating index and Table of 
Contents etc.  
   
View Menu: The options available under view menu are; Display master items, 
Display non-printing items, Zoom in, Zoom out, Actual size, Fit in window, 
Entire paste board  Zoom to (25%, 50%, 75% etc.), Show / Hide rulers, Snap 
to rulers, Zero Lock, Show Hide guides, Snap to guides, Lock guides, Clear 
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ruler guides, Send guides to back, Show Hide Scroll bars . 
The options in this menu bar help us to show or hide the features like 
rulers/guides/scroll bars etc., to see the content zoomed either by providing the 
% of zoom or by fixing it to the window or the actual size, we cal also zoom out 
if it is zoomed in. One can also snap and lock the object(s) either to the ruler or 
to the guides. 
 Window Menu : The options available under this menu are; Arrange icons, 
Tile Cascade, Show / Hide Tools, Show / Hide Control Pallet, Show / Hide 
Colors, Show / Hide Styles, Show / Hide Layers, Show / Hide Master page, 
Show / Hide Hyperlinks, Plug-in Pallets (show library / show scripts). These 
options help to toggle the show / hide of different pallets. 
Help Menu: Provides help on PageMaker  
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                                             EXPERIMENT NO. 10 

 Objective: To study basic features of animation tools like flash. 
 
Hardware and system software requirement: P-IV Processor, Ram 256mb, HDD 40 
GB , Windows 
. 
Software requirement: Windows 2003, windows XP. 
Theory  :  
 

HOW TO START AND WORK ON FLASH 
To open flash 

 Step 1: Click on Start 
 Step 2: Click Program 
 Step 3: Click Macromedia Flash 
 After doing this you will get the flash screen, which looks like as given below:  
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The default file extension  for a Flash movie file is .fla. Flash is used for 
creating Vector Animation Movie. We can publish our flash movie file in .htm, 
.swf, .jpg, .gif, .exe, .mov, .png or as a projector file. 
 DIFFERENT MENUS 
  

File Menu: Under file menu apart from the regular features, the other options 
available are Import, Export Movie, and Export Image. With these options you 
can import any image/movie or can export your complete movies or the scene 
as an image. Publish setting, Publish preview and Publish options helps you to 
publish your movie in the desired format, and before publishing you can 
preview the movie.  
  
Edit Menu: Apart from the regular features like cut, copy, paste etc. it also 
provides an option called Edit Symbol. This option helps us to edit the symbol 
(Button). The four states of button are: Over, Down, Hit and 
 View Menu: Options available are Goto, 100%, Show Frame, Show All. 
These options 
 
helps to goto a particular frame (first, last, next, previous) or scene, shows the 
current frame or all the frames. Also available are Outline, Timeline, Workarea, 
Rulers, Grid, Snap. With the help of these options you can the view the frames 
as outlines, toggles on/off the timeline/workarea/rulers/grid. Snap helps to 
snap the object to the grid. 
 
Insert Menu: The options Layer, motion guide, Frame, Key Frame, Blank Key 
Frame, Scene etc helps to insert the desired option(s). Convert to Symbol 
option helps to convert the editable object to Symbol / Button / Movie clip etc. 
Modify Menu: The options under this menu helps to modify the object / layer / 
movie scene etc. Under Transform option you have Scale, Rotate, Rotate Left, 
Rotate Right, Flip Horizontal, Flip Vertical; these options help to modify the 
object / image. Under Arrange option you have Bring to Front, Send to Back, 
Move Ahead, Move Behind these help to arrange the object in order (in a 
layer). Other options available are; Group, Ungroup, Align (for grouping / 
ungrouping / align objects), Break apart (converting a symbol to editable 
object), Frames > Reverse (to reverse the frames of movie) and Instance 
(used for providing properties to the symbols. With the help of this option you 
can attach an Action to the symbol / button. 
 
Control Menu: The options available under this menu are for controlling the 
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movie i.e Play, Forward, Rewind, Test Movie, Test Scene, Play in Loop etc . 
  
Libraries Menu: Under this you will find the Libraries for Buttons, Advance 

Buttons Graphics, Movie Clips and Sound. 
DIFFERENT TOOLS 
Arrow tool 

  
Use the arrow tool to select entire objects by clicking them or by dragging to 
enclose them within a rectangular selection marquee . 
  
 Lasso tool      
               Use the lasso tool and its polygon lasso modifier to select objects by 
drawing either a freehand or straight-edged selection area. When using the 
lasso tool, you can switch between the freeform and straight edged selection 
modes. 
 
Text tool (“A” in the toolbar). 
Use the text tool to write anything in your scene/movie. The modifiers available 
are, font style, font size 
color, Bold, italic, alignment, paragraph and text field. 
 
 
 
 
 
 
You can use the line, oval, and rectangle tools to easily create these common 
shapes. The oval and rectangle tools let you stroke and fill the shape as you 
draw it. The rectangle tool oval and rectangle tools let you stroke and fill the 
shape as you draw it. The rectangle tool 
. 
 

  
 
Line tool: Line tool can have only the thickness 
and the style. You can customize the list of 
options available with the line width and line style 

modifiers . 
 
 
Oval tool  Click the oval tool and then draw an oval object. Using the fill color 

and stroke color modifier respectively you can fill the oval and also can have 
a different colored outline. Also you can define the thickness and the style of 
the outline of the oval object. 

  
 
 
 

 Rectangle tool: Click the rectangle tool and then click the round rectangle 
radius modifier to define a 20 point curve. The more you give radius the 
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more it will be of circular. Here also you can set the outline style and thickness. 
 
Pencil tool: the pencil tool is unique to Flash. Use it to draw lines, shapes, or 
freehand forms. The pencil tool has three modifiers; straighten, smooth and 
ink. After you draw lines, Flash straightens or smoothes them. The amount of 
straightening or smoothing depends on the selected drawing mode . 

 
 
 
 
 
 

 
  
 
 

 
 
Lines drawn with Straighten, Smooth, and 
Ink mode, respectively  
 
 Brush tool   The brush tool draws brush-
like strokes as if you were painting. The 
brush tool lets you 
create special effects, including calligraphic 
effects and painting with the image in an 
imported bitmap. 
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The brush tool has these modifiers, Paint options, fill color, gradient, brush 

size, brush shape and 
lock fill. The brush tool 
has different paint 
options as shown in the 
picture next the tool bar. 
Using these options you 
can draw or fill an object 
as shown below . 
 

Original image, Paint Normal, Paint Behind, Paint Fills, 
Paint Selection, and Paint Inside 
Paint Normal paints over lines and fills on the same 
layer 

 
Paint Behind paints in blank areas of the Stage, leaving lines and fills 
unaffected 
 
Paint Fills paints fills and empty areas, leaving lines unaffected 
Paint Selection paints the selected fill. 
Paint Inside paints the fill in which you start a brush stroke and never paints 
lines  
Paint bucket tool Used to change the color of existing paint and fill empty 
areas surrounded by lines. You can fill an area with a gradient the same way 
you can with a solid color. 
With  Inkbottle  you can stroke lines and shapes with only solid colors you've 
already drawn, but not with gradients or bitmaps. Stroke attributes also include 
line width and line style . 
 
 
 
 
 
 
 
 
The Eraser tool  erases lines and fills. Customize it to erase only lines, only 
fills, only selected fills, or only the fill on which you started erasing. The eraser 
tool can be either round or square, and have one of five sizes  Erase Normal 
erases lines and fills on the same layer Erase Fills erases only fills; lines are 
not affected . Erase Lines erases only lines; fills are not affected Erase 
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Selected Fills erases only the currently selected fills and does not affect lines 
selected or not. Erase Inside erases only the fill on which you begin the eraser 
stroke. If you begin erasing from an empty point, nothing will be erased. Lines 
are unaffected by the eraser in this mode . 
The faucet option  under eraser tool erases the fill color. You can also erase 
lines with the  faucet modifier. 
 
                                                                                                                                                                                                                                        


